Agilent 7100 Capillary Electrophoresis System in Empower

Technical Note

This technical guide describes the configuration and implementation of the G7100A Capillary Electrophoresis in Empower 3.
## Contents

Introduction ......................................................... 3

Set up and Configuration of CE in Empower 3 ............... 5
  CE Instrument set up ........................................... 5
  The CE Driver .................................................... 5
  Various Configuration Steps for CE in Empower .......... 5

Using the CE in Empower ........................................ 12
  The CE Status Dashboard in Empower – Direct Control 12
  Creating an Instrument Method ................................. 15
  Replenishment and Conditioning .............................. 25
  Indirect detection ................................................. 28
  Application of external pressure .............................. 28
  Empower features for CE Instrument Control ............ 33
  Known Limitations/Not tested configurations: .......... 33

Extended CE driver features available in Agilent OpenLAB CDS
ChemStation Edition ................................................. 34

Additional Information ............................................. 36
  Waters ..................................................................... 36

APPENDIX - Examples .............................................. 37
  Example: Single test run .......................................... 37
  Example: Multiple injections using the IQ Kit for CE .... 39
  Example: Indirect detection using the Plating Bath Buffer 41
Waters Instrument Control Software (ICS) is Waters Corporation’s adoption of the Agilent Instrument Control Framework (ICF) for their data systems. This guide describes how to configure and use the 7100 Capillary Electrophoresis (CE) in Waters Empower environment.

Empower 3 offers all key functions to control the G7100A Agilent Capillary Electrophoresis system. All established techniques are feasible, such as the use of direct and indirect detection modes, use of special electrolyte systems (containing micelles or gel matrices) and also capillary isoelectric focusing (cIEF) or capillary electrochromatography (CEC). The application of external high pressure is supported.

For data analysis, Empower offers processing tools for peak integration and calculation of concentrations in CE specific mode.

### Table 1  Supported and unsupported configurations using CE in Empower

<table>
<thead>
<tr>
<th>Waters Instrument Control Packages</th>
<th>Agilent ICF / Agilent LC Driver</th>
<th>CE support in Waters Empower 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICF Support v2.2 #667005584</td>
<td>A.02.04</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>A.02.14</td>
<td>G7100A Capillary Electrophoresis, with the internal components:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• G7150A CE Mainframe</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• G7151A DAD</td>
</tr>
<tr>
<td></td>
<td>Min. Firmware B.06.73 (older firmware does not support the use of RFID Tags for the DAD UV-Lamp)</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>G1600 Capillary Electrophoresis</td>
<td></td>
</tr>
<tr>
<td>ICF Support v2.2 #667005449</td>
<td>A.02.03 DU2</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>A.02.13</td>
<td>G7100A Capillary Electrophoresis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G1600A Capillary Electrophoresis</td>
</tr>
<tr>
<td>And any lower integration</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Introduction

NOTE

Ensure that the Agilent LC/CE modules in the system *meet or exceed* the minimum firmware requirements specified by the 3rd-party CDS software vendor and Agilent’s firmware set/firmware interoperability requirements. Agilent recommends using the latest available firmware set.

Set up and Configuration of CE in Empower 3

CE Instrument set up

2. Set up the CE system.
3. The CE uses LAN communication, e.g. via the multiport ethernet card. Connect the CE to the LAC/E box. If another instrument is connected to the LAC/E, connect via switch or hub.
4. Switch the instrument on.

The CE Driver

The CE driver is part of the LC Driver and not listed as a separate component. Therefore, Agilent ICF consists of two components; the Waters integration adds one additional component. All three components must be present in Control Panel > Programs and Features:

![Figure 1 Components in Programs and Feature](image)

Various Configuration Steps for CE in Empower

To run CE in Empower the following items are required:

- A CE specific project for data collection
- The configuration of the CE instrument

Creating a CE Project

Configure a specific CE project to review the acquired data later.

1. Select File > New > Project to open the New Project Wizard.
2. Follow the instructions in the wizard screen and proceed with default settings if no other values are given via Standard Operating Procedure (SOP).
3. In the **New Project Wizard > Options** window make sure to enable **CE/CIA**.

![Image of New Project Wizard - Options window](image)

**Figure 2**  Enabled Options for the project

**PreConfiguration of CE in Empower**

For the following configuration options the PreConfiguration Utility is required to access the CE configuration in the CE configuration editor:

- Defining the **Pressure Unit** (see also chapter Known Limitations on page 33)
- Defining the **Temperature Control** mode (**Temperature Control** switched on by default)
- Defining the **Analog In Signal** (see also chapter Known Limitations on page 33)

**NOTE**

Selecting PSI as pressure unit, the CE status dashboard shows the pressure in PSI while the online plot and the resulting Aux Traces on the Chromatogram offer the values in mbar/bar.
Streamline the process of setting up and configuring CE in Empower 3 with the following steps:

**Software required**
ICF Support v2.2 (See chapter Additional Information on page 36 for Waters support documentation TECN134936402).

1. In the Empower Configuration Manager, select **Tools > Agilent PreConfiguration**.

![Configuration Manager](image1.png)

**Figure 3** Configuration Manager

2. Enter the IP address or host name of the LAC/E box that your instrument is connected to into the pop-up screen **Configuration Directory** and click **Connect**.

![Configuration Directory](image2.png)

**Figure 4** IP address to connect

**Note**
Do not enter the IP address of the instrument here.
3 Once the IP address is connected, click **New** to open the PreConfiguration Utility.

![Configuration Utility](image)

**Figure 5  Configuration of the CE**

4 In the Configuration Editor select the Agilent 7100 CE and click **Auto Configure**.

5 Enter the IP address of the instrument and click **OK**. The instrument is detected and the CE and DAD appear on the right-hand side of the configuration window.

**Hint**
The default IP address is 192.168.254.11. Please refer to the *G7100A User Manual* if an IP address change is required.
Set up and Configuration of CE in Empower 3

Double-click CE G7150A on the right side of the window or select it and click **Configure** at the bottom of the screen. The CE configuration window opens.

![CE Configuration Window](image)

**Figure 6** Possible configuration options for CE

- **a** Select the preferred **Pressure Unit** in the CE status dashboard for use in the data and the pressure auxiliary channel.

- **b** If **Temperature Control** is not required, select *Enable analysis with temperature out of range*.

> **NOTE**
> Temperature control is enabled by default. The run only starts once the given temperature is reached. You can change this behavior by deselecting the box. A reboot (and reconfiguration via the PreConfiguration Utility) is required.

- **c** Enable **Acquire** for the **Analog In Signal** to collect data.

7 Click **OK** to close the screen.

8 Click **OK** to close the configuration editor.

9 Click **OK** to close the PreConfiguration Utility.
Configuration of CE in Empower

Refer to the Waters Empower documentation for installation and configuration of the LC/CE system in Empower.

1. Open the **Waters DHCP Server Configuration** window by entering the following command in the windows command line:
   
   ```
   C:\Empower\Instruments\Waters DHCP Server Configuration.exe.
   ```
   
   OR

   In the Empower Configuration Manager window, select **Node** in the tree on the left-hand side, then right-click on the node you want to add the instrument to and select **Properties**. Select the **Configure DHCP** tab and click **Configure DHCP**.

2. Add the **IP Address** and **MAC Address** manually for the CE mainframe.

3. Select **Instrument Type AgilentLC** and click **OK** to leave the screen.

4. Access the **Nodes Properties** in the Empower Configuration Manager and verify that the Instrument is shown as OK.
Generate a new chromatographic system with the newly configured instrument using **File > New > Chromatographic System**. Follow the instructions on the screen.

**Figure 8** Generating a new chromatographic system
Using the CE in Empower

The CE Status Dashboard in Empower – Direct Control

1. Start Empower and open the Run Samples Screen.
2. Select the CE/CIA specific project for data collection together with the CE system.
3. The CE Status window displays all available modules with their status information. Details can be seen by hovering over the status bar with the mouse.

Figure 9  CE dashboard status information

4. The given space does not allow enlarging the CE status window to full size, therefore a vertical scrollbar is present to adjust the required section of the status dashboard.

Figure 10  CE Status dashboard – upper part
Figure 11  CE Status dashboard – lower part

Each component of the instrument is represented by an icon on the CE status dashboard. Right-click an icon to access direct control. A context menu appears and an action can be performed. Some contextual actions require further user interaction. Click OK to trigger the action.

Figure 12  Example of direct control - actions available for bottle icon
Following major actions are accessible via the CE Status dashboard only (list does not claim to be exhaustive):

- Change Cassette
- Switch on lamp/Switch off lamp
- Set Inlet Vial
- Set Replenish Vial
- Unload Replenish Lifter
- Unload Inlet Lifter
- Set Outlet Vial
- Unload Outlet Lifter
- Flushing Capillary by Flush
- Injection by Apply Pressure
- Apply Voltage
- Replenish Vials
- Change Bottles
- Get Vial

All actions are performed immediately and the changes are reflected in the graphical user interface (GUI). The system is in **not ready** state (yellow), while performing these actions. After the action finishes, the instrument resumes an **idle** state (green). Any direct change of a parameter in the direct control menu (control and/or method) does not change the current instrument method.

**NOTE**

It is not possible to see the detector signal while flushing the capillary. A feasible workaround is to check the numerical value of the detection wavelength, which is displayed in the DAD part of the GUI (left side).
Creating an Instrument Method

The instrument method contains all the parameters necessary to perform the sample acquisition.

1. Open the instrument method editor, for example via Edit > Instrument Method.

2. Click through the various tabs and enter the instrument method parameters.

3. Save the instrument method under a dedicated name. This method can now be used as part of a method set.

The instrument method editor offers various tabs:

- **Instrument Method tab**: The instrument method tab provides access to all method parameters of the CE system, one tab per module, CE and DAD. Select the appropriate tab to enter the method parameters. For details on the parameters refer to the online help and the CE or DAD user manual.

- **Pretreatment Method tab**: There are no pretreatment steps available for CE.

- **Auxiliary Channels tab**: Offers selection of auxiliary traces during a run, e.g. the CE leak current.
Using the CE in Empower

d  General tab: Offers option to mark this method as shutdown method, see page 20. Allows selective shutdown of the CE and DAD.

e  Instrument Configuration tab: The CE system configuration is available in the Instrument Configuration tab. All settings in this dialog must be defined using the PreConfiguration Utility. Changes in this section of the method are not applied to the system; they are saved with the instrument method only. Any changes, such as enabling temperature control, need to be done in the PreConfiguration Utility to apply the new configuration to the physical instrument. In addition, the LAC/E box has to be rebooted and a new autoconfiguration is required in order to adjust the new configuration with the LC Driver and Empower.
**Instrument Method tab**

*The CE method Screen*

The CE method screen contains all parameters used to adjust the separation, meaning the home vials can be defined as well as **Cassette Temperature**, **Voltage**, and **StopTime**. Press F1 on the keyboard to access the online help, offering explanations for each method parameter. The left-hand side of the method screen includes the initial starting parameters.

![CE method screen](image)

**Figure 14  CE method screen**

**NOTE** Enter a **StopTime** for the CE and/or the DAD. For run execution a Run Time is specified in Empower later, ensure that both values are synchronized. For more details, see section Executing Runs on page 21.
Using the CE in Empower

**Hint**

Depending on the used SOP, the following best practices are used.

- **a** Ensure that Empower **Run Time** and Agilent Module **Stoptime** (for one module) are synchronized.
- **b** Set an Agilent Module **Stoptime** of 1 min, and set the real sample time in the sample set screen.

If an entered parameter is out of range, a warning sign is shown. By hovering with the mouse pointer over the parameter, the message displays the possible range, e.g. **Voltage is out of range [-30kV to 30 kV]**.

![Figure 15 Out of range handling](image)

The right-hand side of the method screen offers additional features. The online help explains each of the features:

- Replenishment
- Preconditioning
- Injection
- Timetable
- Postconditioning
The DAD method screen

On the left side, the DAD method offers the main method parameters to acquire up to eight signals. Refer to the online help to learn more about each parameter. Remember to set the stop time either to CE or to the same time as the Empower run time.

The right side offers additional method parameters, e.g. for spectra collection and a timetable, in order to change parameters during a run.

Unlike with other Agilent DAD, there is no VIS-lamp available.

Figure 16  DAD method screen
Using the CE in Empower

**General Method Tab**

Empower offers the option of selecting a **System Shutdown Method**, which is executed at the end of the sequence.

1. To generate a shutdown method, define the desired shutdown conditions, such as vials and times in the CE/DAD method screen first and select **Shutdown after Run**. It is possible to perform a selective shutdown, for example only the DAD.

2. To execute the shutdown method, either select the shutdown method in the Run Sample set window or load the shutdown method as the last line of the sequence.

![Shutdown Method screen](image)

**Figure 17**  Shutdown Method screen
Executing Runs

The Empower Run Time is shown in the Single Run tab and in the sample sets. The Agilent Stop Time is an instrument method parameter.

- If the Run Time is longer than the instrument method’s Stop Time, the Run Time is used for the measurements, regardless of what is stated in the instrument method. The online plot and the resulting electropherogram end with the Run Time.
- If the Run Time is shorter than the instrument method’s Stop Time, the online-plot stops at the Run Time but the run continues until the end of the method’s Stop Time. The resulting electropherogram ends at the method’s Stop Time. The longer time is used for recording data.

The method’s Post Time is independently added after the Stop Time, and no data is recorded during the post time. The next sequence run starts after the Post Time of the previous run is finished.
Single Runs

1. Enter or select the required values and parameters in the **Single** tab for a single run execution. Click the **Inject** icon to start the single run.

2. During the run execution, you can stop the run at any time by clicking the red Stop button.

![Figure 18 Single Run tab](image_url)

---

**Using the CE in Empower**

---

**Agilent 7100 CE in Empower Environment**
Sequence Execution/Sample sets

Empower offers multiple injections from the same vial as well as consecutive injections from different injection vials. The details have to be added to the sample/sample set table (sequence), depending on the required workflow.

1 Click the Sample tab to open the table.

2 Click into the first line to fill in the appropriate values. For the following values the entries are mandatory:
   - Vial position
   - Injection volume
   - Number of injections
   - Sample name
   - Method set
   - Run time (use the same time as in the instrument method)

   The parameter **Inj. Vol (µl)** requires a value. This value is *not* used for the injection, but it is reported. The instrument method parameters (for example: pressure and time) are used for the injection.

   (Instead of volume the quantifiable parameters are pressure × time for hydrodynamic injection, or voltage × time for electrokinetic injection).

   Entering an injection volume of 0 µl does not result in a blank run. The value is ignored for the run execution, but it is reported.

3 Start the sequence. Reminder: During run execution, the red Stop button allows you to stop the run at any time.
NOTE

If a vial is missing, the current run is stopped and the whole sequence is aborted. The option **Next sample on Fault** does not apply.

4 It is possible to shut down the CE/DAD at the end of the sample set. Load the shutdown method (for details see section General Method Tab on page 20) as the last line of the sequence.
Replenishment and Conditioning

**Replenishment** allows to automatically change the buffer of a vial either in serial or parallel mode.

**Preconditioning** and **Postconditioning** offers conditioning of the capillary.

These settings are method settings and therefore expected each time the method is running. If this is not wanted, make sure to generate methods with and without replenishment and/or pre/postconditioning.

During multiple analyses the buffer must be refreshed after a certain number of runs. Typically, the exchange of the buffer is done every 3 - 10 runs. Depending on the stability of the buffer, it is sometimes necessary to refresh it before each run.

**NOTE**
Using the replenishment as a part of the method, the replenishment is carried out for each run where this is part of the method.

If you want the refresh to be done less, ensure to create at least two methods.

Example:
- Run 1 method A with replenishment
- Run 2 method
- Run 3 method
- Run 4 method with replenishment
- Run 5 method
- Run 6 method
- Run 7 method with replenishment
- Run 8 method
- Run 9 method

The replenishment system provides a quick way to change the buffer automatically. The system removes the used buffer from the vials and transfers it into the waste bottle. Then the vials are filled with fresh buffer from the electrolyte reservoir.
Using the CE in Empower

Refer to the G7100A User manual on the requirements for the bottles, as only specific bottles can be used. For example, they need to be pressure-stable.

The waste bottle should be 500 ml, whereas the electrolyte bottle can also be a 100 ml bottle. Both bottles are included in the accessory kit.

Following replenishment, tasks can be set up in the CE replenishment table in the Instrument method:

- **Empty vial**: empties a vial into the waste bottle
- **Fill vial**: fills a vial to a user-selectable level from the electrolyte reservoir
- **Clean tubes**: flushes the replenishment system to clean the tubes
- **Replenish vial**: empties a vial into the waste and fills it up from the electrolyte reservoir
- **Wait**: waits for a specified time

![Figure 19 Replenishment Table](image)
It is possible to execute replenishment in parallel, which decreases the overall analysis time as replenishment and pre- or postconditioning are executed simultaneously.

**NOTE**

For parallel replenishment, the vials for the first run must be filled with the correct solutions, because the replenishment starts at the end of the run.

**NOTE**

To efficiently clean the replenishment system after use, the special functions **Flush Tubes** and **Clean Level Sensor** should be performed. This advanced cleaning is only available in the Agilent LabAdvisor software.
**Indirect detection**

The indirect detection mode allows the application of indirect photometric detection of non-UV absorbing analytes like inorganic cations, inorganic anions and small carbohydrates.

To attain indirect photometric detection, an ionic compound with a high UV absorbance intensity is used as the background electrolyte (BGE). During the separation any non-absorbing analyte causes a reduction of the high background signal, resulting in negative peaks.

Empower can record and calculate positive and negative signals. If most of the analytes are non-absorbing, the detector signals for signal and reference wavelength can be inverted, so that most of the peaks are positive.

**Application of external pressure**

For some special applications using high viscosity buffer solution (e.g. a gel matrix in the CGE and cIEF) the capillary can be conditioned using external high pressure to ensure that the capillary is filled in adequate time.

Two additional modes are available for configuration:

- **CEC**: Capillary Electrochromatography allows high pressure to be applied on both electrolyte vials in the run during the high-voltage application to prevent outgassing and bubble formation.
  
  A connected external pressure supply is required for this mode. When this mode is selected, additional pressure options are available in the instrument method:
  
  - High pressure flush in **Preconditioning, Injection** and **Postconditioning**.
  
  - External pressure as method setpoint and timetable entry.

- **CE/p**: additional external pressure connected
Configure CEC or CE/p mode

If an external pressure source is available (pressure 2 - 12 bar) and connected to the CE device, these modes can be configured in the Module Options tab, which can be found below the CE status dashboard. Select the required CE Mode.

![Figure 20  Additional CE mode](image)

When the External Pressure Installed check box is selected, the gas cylinder is shown in the CE status dashboard accessible via the Instrument Status tab. High pressure can now be applied by right-clicking on the gas cylinder.

![Figure 21  Access to external pressure](image)
NOTE

Make sure to reboot the LAC/E box after any mode change in the Module Option tab. Without a reboot (OR close Empower and end the processes InstrumentServer.exe and AgilentPlugInServer.exe and reopen Empower) the configuration changes are not correctly applied and can result in various issues.

• If the PreConfiguration Utility was used, it is essential to create a new autoconfiguration.
• Verify that other instruments attached to the Workstation or LAC/E are not collecting data. Rebooting the LAC/E will interrupt data collection on all instruments attached and the lost data will not be able to be recovered.
Method impact for CEC or CE/p mode

If the new pressure section does not appear in the method section, the configuration mode has not been applied correctly. Confirm that the correct mode is defined in the Module Option tab and then reboot the LAC/E. If a PreConfiguration exists, run a new autoconfiguration in addition.

- **If CE/p** is selected, the instrument method offers high pressure settings as additional method parameters on the right-hand CE method screen:
  - Preconditioning (right-hand CE method screen)
  - Injection (right-hand CE method screen)
  - Timetable (right-hand CE method screen)
  - Postconditioning (right-hand CE method screen)

- **If CEC** is selected, the instrument method offers high pressure settings as additional method parameters on the right-hand CE method screen:
  - Preconditioning (right-hand CE method screen)
  - Injection (right-hand CE method screen)
  - Timetable (right-hand CE method screen)
  - Postconditioning (right-hand CE method screen)

Only in CEC mode, the instrument offers an additional initial value **Pressure** on the left-hand CE method screen. Selecting **External**, the pressure is applied to both home vials during run execution (see Figure 23).
Using the CE in Empower

Figure 22 Applying external pressure – new menu

Figure 23 Applying external pressure during a run
Empower features for CE Instrument Control

Empower 3 offers all key functions to control the G7100A Agilent Capillary Electrophoresis system. All established techniques are feasible, such as the use of direct and indirect detection modes, use of special electrolyte systems (containing micelles or gel matrices) and also capillary isoelectric focusing (cIEF) or capillary electrochromatography (CEC). The application of external high pressure is supported.

For data analysis, Empower offers processing tools for peak integration and calculation of concentrations in CE specific mode.

Known Limitations/Not tested configurations:

- **Pressure Unit** configuration
  Selecting PSI as pressure unit, the CE status dashboard shows the pressure in PSI, while the online plot and the resulting Aux Traces on the Chromatogram offer the values in mbar/bar. The correct pressure is applied.

- **Analog In**
  The feature Analog In has not been explicitly tested, but the functionality is present.

- **MS installed**
  The feature MS installed has not been tested.

![Agilent 7100 CE in Empower Environment](image)
Extended CE driver features available in Agilent OpenLAB CDS ChemStation Edition

The following items are not CE driver features, hence they are not available in Empower environment.

Control and Action Menus

In Non-Agilent CDS all actions and direct controls can only be accessed via the CE Status dashboard. There are no menu items for instrument control in the Empower menu bar.

Fraction Collection

The system offers **Set up for Peak Fraction Collection** whether a fraction collector is present or not. This Macro is only available in OpenLAB CDS ChemStation Edition.

User vials

The CE driver offers to select user vials (1-10) as part of the method. User vial parameters are defined in the sequence table as the hosting CDS interlinks method and sequence. User vials are not available in Non-Agilent CDS environment.

Capillary Catalog, Capillary Handling

OpenLAB CDS ChemStation Edition offers a capillary catalog database. This database is not available in Non-Agilent CDS environment. Workaround: Add the capillary information to the **Method Comments**.

Sample Diagram

OpenLAB CDS ChemStation Edition offers a sample diagram informing about each vial's purpose. This table is not available in Non-Agilent CDS environment.

Vial Table

OpenLAB CDS ChemStation Edition offers a vial table, giving an overview of vial position, name and comment.
Calibration Curve options

The following Calibration Curves are unavailable in Empower:

- Mobility correction
- Calibration Type cIEF
- Calibration for determination of isoelectric points or molecular weights
Additional Information

Waters

Additional information on the PreConfiguration Utility is provided on the Waters Support Webpage for registered users:

http://www.waters.com/waters/support.htm?lid=134936402&cid=511442&type=TECN

Document reference: TECN134936402

Title: Using the Agilent PreConfiguration Utility with Agilent ICF Support Version 2.2
APPENDIX - Examples

Example: Single test run

For testing the functions of the 7100 CE and Empower 3 a test method can be created. The equipment and method parameters can be summarized as follows:

Capillary: Fused silica capillary 50 µm ID, 48.5 cm total (40 cm effective), ext. Light path (G1600-60232)
Electrolyte: 20 mM Borate (from IQ-Kit: 5063-6514)
Home vials: 1 and 2 (filled with electrolyte solution)
Sample: 4-Hydroxyacetophenone solution 1 mmol/l (from IQ-Kit: 5063-6514)

NOTE
The sample has to be diluted 1:10 before the run.

Voltage: +30 kV
Temperature: 25°C
Stop Time: 4 min
Preconditioning: 300 s (from electrolyte vial 3 into waste vial)
Injection: 50 mbar for 10 s (from injection vial to outlet vial)
Post-injection: 50 mbar for 5 s (from inlet vial to outlet vial)
DAD: Signal: 200 nm (BW 5 nm)
Reference: 360 nm (BW 100 nm)
Peakwidth: >0.025 min (10 Hz)
DAD Timetable: 0.5 min Balance

The run can be executed as single run (in this case save the instrument method as well as the method set). If defined in the method, the online plot shows the selected signals and the final result electropherogram can be obtained in the Browse menu of Empower or via the projects.

NOTE
Ensure that the Run Time is the same as defined in the CE/DAD method.
Figure 25  Online plot during the run

Figure 26  Resulting electropherogram
Example: Multiple injections using the IQ Kit for CE

For testing multiple injections in one sequence, the instrument method and the experimental setup described in section Example: Single test run can be used. See the sequence table (Figure 27) and the overlay of the resulting electropherograms (Figure 28).

A set of six injections was used to calculate system precision. The peak areas and relative standard deviations (Excel: STDEV) for the areas, migration times and the corrected areas are summarized in the following table.

<table>
<thead>
<tr>
<th>Injection</th>
<th>Area</th>
<th>tm [min]</th>
<th>tm [s]</th>
<th>corr. Area (area/tm [s])</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injection 1</td>
<td>50049</td>
<td>2.730</td>
<td>163.80</td>
<td>3.05549E+02</td>
</tr>
<tr>
<td>Injection 2</td>
<td>50547</td>
<td>2.723</td>
<td>163.38</td>
<td>3.09383E+02</td>
</tr>
<tr>
<td>Injection 3</td>
<td>50189</td>
<td>2.717</td>
<td>163.02</td>
<td>3.07870E+02</td>
</tr>
<tr>
<td>Injection 4</td>
<td>49767</td>
<td>2.711</td>
<td>162.66</td>
<td>3.05957E+02</td>
</tr>
<tr>
<td>Injection 5</td>
<td>49187</td>
<td>2.706</td>
<td>162.36</td>
<td>3.02950E+02</td>
</tr>
<tr>
<td>Injection 6</td>
<td>49579</td>
<td>2.702</td>
<td>162.12</td>
<td>3.05817E+02</td>
</tr>
<tr>
<td>Average</td>
<td>49886</td>
<td>2.715</td>
<td>162.89</td>
<td>3.06254E+02</td>
</tr>
</tbody>
</table>

Deviation STDEV: 0.96 % 0.39 % 0.39 % 0.72 %

Figure 27 Sequence table for multiple injections
Using Empower 3 in combination with the Agilent 7100 CE, a good relative standard deviation around 1 % for the peak areas and below 0.5 % for the migration times were obtained. These satisfactory values are achieved by a special self-regulating injection procedure, which significantly improves the injection precision. For more information please refer to the *Agilent CE Manual*. 

**Figure 28  Overlay of six consecutive injections**
Example: Indirect detection using the Plating Bath Buffer

A test method can be created using the *Plating Bath Buffer* for testing the indirect detection functions. The following reagents and parameters can be used:

- **Capillary:** Fused silica capillary 50 µm ID, 80.5 cm total (72 cm effective) (G1600-62211)
- **Electrolyte:** Plating Bath Buffer (Agilent: 5064-8236)
- **Home vials:** 1 and 2 (filled with electrolyte solution)
- **Sample:** Suitable *Plating Bath Mixture* (laboratory made)
- **Voltage:** -30 kV
- **Temperature:** 25°C
- **Stop time:** 15 min
- **Preconditioning:** 240 s (from electrolyte vial 3 into waste vial)
- **Injection:**
  1. Injection vial to outlet vial: 50 mbar for 10 s
  2. Post-injection: 50 mbar for 5 s (from inlet vial to outlet vial)
- **DAD:**
  - **Signal A:** 350 nm (BW 20 nm), reference: 275 nm (BW 10 nm)
  - **Signal B:** 275 nm (BW 10 nm), reference: 350 nm (BW 20 nm)
  - **Peak width:** >0.025 min (10 Hz)
  - **Timetable:** 1.0 min Balance

Comparing the reversed wavelength the peaks can be shown as positive or negative peaks.

![Figure 29 Indirect detection](Image)

**Figure 29** Indirect detection
It is evident from the electropherogram in Figure 30 that the selected wavelength values result in positive peaks for the non-UV absorbing analytes: sulfate, malate, hypophosphite, phosphite and lactate. The nickel-complex has its own UV intensity and results in a negative peak. The figure also shows that the integration and evaluation of the peak areas are possible for positive and negative peaks in the same signal.

![Auto-Scaled Chromatogram](image)

**Figure 30** Integration and reporting of positive and negative peaks